
Sun Java System Connector for
Microsoft Outlook 7.2 User's
Guide

Sun Microsystems, Inc.
4150 Network Circle
Santa Clara, CA 95054
U.S.A.

Part No: 819–4411–10
March 2007



Copyright 2007 Sun Microsystems, Inc. 4150 Network Circle, Santa Clara, CA 95054 U.S.A. All rights reserved.

Sun Microsystems, Inc. has intellectual property rights relating to technology embodied in the product that is described in this document. In particular, and without
limitation, these intellectual property rights may include one or more U.S. patents or pending patent applications in the U.S. and in other countries.

U.S. Government Rights – Commercial software. Government users are subject to the Sun Microsystems, Inc. standard license agreement and applicable provisions
of the FAR and its supplements.

This distribution may include materials developed by third parties.

Parts of the product may be derived from Berkeley BSD systems, licensed from the University of California. UNIX is a registered trademark in the U.S. and other
countries, exclusively licensed through X/Open Company, Ltd.

Sun, Sun Microsystems, the Sun logo, the Solaris logo, the Java Coffee Cup logo, docs.sun.com, Java, and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC
International, Inc. in the U.S. and other countries. Products bearing SPARC trademarks are based upon an architecture developed by Sun Microsystems, Inc.

The OPEN LOOK and SunTM Graphical User Interface was developed by Sun Microsystems, Inc. for its users and licensees. Sun acknowledges the pioneering efforts
of Xerox in researching and developing the concept of visual or graphical user interfaces for the computer industry. Sun holds a non-exclusive license from Xerox to
the Xerox Graphical User Interface, which license also covers Sun's licensees who implement OPEN LOOK GUIs and otherwise comply with Sun's written license
agreements.

Products covered by and information contained in this publication are controlled by U.S. Export Control laws and may be subject to the export or import laws in
other countries. Nuclear, missile, chemical or biological weapons or nuclear maritime end uses or end users, whether direct or indirect, are strictly prohibited. Export
or reexport to countries subject to U.S. embargo or to entities identified on U.S. export exclusion lists, including, but not limited to, the denied persons and specially
designated nationals lists is strictly prohibited.

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO
THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Copyright 2007 Sun Microsystems, Inc. 4150 Network Circle, Santa Clara, CA 95054 U.S.A. Tous droits réservés.

Sun Microsystems, Inc. détient les droits de propriété intellectuelle relatifs à la technologie incorporée dans le produit qui est décrit dans ce document. En particulier,
et ce sans limitation, ces droits de propriété intellectuelle peuvent inclure un ou plusieurs brevets américains ou des applications de brevet en attente aux Etats-Unis
et dans d'autres pays.

Cette distribution peut comprendre des composants développés par des tierces personnes.

Certaines composants de ce produit peuvent être dérivées du logiciel Berkeley BSD, licenciés par l'Université de Californie. UNIX est une marque déposée aux
Etats-Unis et dans d'autres pays; elle est licenciée exclusivement par X/Open Company, Ltd.

Sun, Sun Microsystems, le logo Sun, le logo Solaris, le logo Java Coffee Cup, docs.sun.com, Java et Solaris sont des marques de fabrique ou des marques déposées de
Sun Microsystems, Inc. aux Etats-Unis et dans d'autres pays. Toutes les marques SPARC sont utilisées sous licence et sont des marques de fabrique ou des marques
déposées de SPARC International, Inc. aux Etats-Unis et dans d'autres pays. Les produits portant les marques SPARC sont basés sur une architecture développée par
Sun Microsystems, Inc.

L'interface d'utilisation graphique OPEN LOOK et Sun a été développée par Sun Microsystems, Inc. pour ses utilisateurs et licenciés. Sun reconnaît les efforts de
pionniers de Xerox pour la recherche et le développement du concept des interfaces d'utilisation visuelle ou graphique pour l'industrie de l'informatique. Sun détient
une licence non exclusive de Xerox sur l'interface d'utilisation graphique Xerox, cette licence couvrant également les licenciés de Sun qui mettent en place l'interface
d'utilisation graphique OPEN LOOK et qui, en outre, se conforment aux licences écrites de Sun.

Les produits qui font l'objet de cette publication et les informations qu'il contient sont régis par la legislation américaine en matière de contrôle des exportations et
peuvent être soumis au droit d'autres pays dans le domaine des exportations et importations. Les utilisations finales, ou utilisateurs finaux, pour des armes nucléaires,
des missiles, des armes chimiques ou biologiques ou pour le nucléaire maritime, directement ou indirectement, sont strictement interdites. Les exportations ou
réexportations vers des pays sous embargo des Etats-Unis, ou vers des entités figurant sur les listes d'exclusion d'exportation américaines, y compris, mais de manière
non exclusive, la liste de personnes qui font objet d'un ordre de ne pas participer, d'une façon directe ou indirecte, aux exportations des produits ou des services qui
sont régis par la legislation américaine en matière de contrôle des exportations et la liste de ressortissants spécifiquement designés, sont rigoureusement interdites.

LA DOCUMENTATION EST FOURNIE "EN L'ETAT" ET TOUTES AUTRES CONDITIONS, DECLARATIONS ET GARANTIES EXPRESSES OU TACITES
SONT FORMELLEMENT EXCLUES, DANS LA MESURE AUTORISEE PAR LA LOI APPLICABLE, Y COMPRIS NOTAMMENT TOUTE GARANTIE
IMPLICITE RELATIVE A LA QUALITE MARCHANDE, A L'APTITUDE A UNE UTILISATION PARTICULIERE OU A L'ABSENCE DE CONTREFACON.

070319@17039



Contents

Preface .....................................................................................................................................................9

1 Sun Java System Connector for Microsoft Outlook Overview ..................................................... 15
What is Sun Java System Connector for Microsoft Outlook? ........................................................ 15
Where to Find Other Information .................................................................................................... 16

2 Installing and Configuring the Software on Your Desktop .......................................................... 17
About the Setup Procedure ................................................................................................................ 17

System Requirements .................................................................................................................. 17
Folder Hierarchies for Migrated Data ....................................................................................... 18
If a Large PST File Conversion Is Interrupted .......................................................................... 19

The Setup Procedure ........................................................................................................................... 19
Step 1: Starting the Setup Wizard ............................................................................................... 19

▼ To Start the Setup Wizard ................................................................................................... 20
Step 2: Installing Microsoft Web Publishing Wizard .............................................................. 21

▼ To Install Microsoft Web Publishing Wizard ................................................................... 21
Step 3: Selecting an Outlook User Profile to Convert .............................................................. 22

▼ To Select a Profile for Conversion ...................................................................................... 23
Step 4: Selecting Personal Folders (.pst) Files to Convert ........................................................ 23

▼ To Select the .pst Files to Convert ....................................................................................... 24
Step 5: Entering Exchange Account Login Information ......................................................... 25

▼ To Enter the Requested Information for Your Microsoft Exchange Mailbox .............. 25
Step 6: Entering New Account Login Information .................................................................. 26

▼ To Enter the Requested Information for Your New Account ......................................... 26
Step 7: Entering Passwords for Protected Personal Folders .................................................... 27

▼ To Enter the Personal Folders (.pst) File Password .......................................................... 27
Step 8: Monitoring the Progress Meter ...................................................................................... 28

3



▼ To Begin Converting Large Personal Folders Files ........................................................... 29
▼ To View a Progress Meter in Real Time ............................................................................. 29

Step 9: Exiting ............................................................................................................................... 29

3 Getting Started ....................................................................................................................................33
Starting Outlook .................................................................................................................................. 33
What You See ....................................................................................................................................... 33
Typical Initial Profile ........................................................................................................................... 34
Accessing Your Inbox ......................................................................................................................... 34
Accessing Your Calendar ................................................................................................................... 34
Accessing Your Contacts .................................................................................................................... 34

4 Configuring Connector for Microsoft Outlook ............................................................................... 35
Configuring Servers and User Accounts .......................................................................................... 35

▼ To Change the Initial Configuration Settings ........................................................................... 35
Configuring Mail Properties .............................................................................................................. 36

▼ To Change Mail Properties ......................................................................................................... 36
Configuring Calendar Properties ...................................................................................................... 38

▼ To Change Calendar Properties ................................................................................................. 38
Configuring Address Book Properties .............................................................................................. 38

▼ To Change Address Book Properties ......................................................................................... 38
Configuring Global Address List Properties .................................................................................... 39

▼ To Change Global Address List Properties ............................................................................... 39
Configuring Store and Logging Properties ...................................................................................... 39

▼ To Change Store and Logging Properties ................................................................................. 39

5 Working with Email Folders ...............................................................................................................41
Accessing Your Inbox ......................................................................................................................... 41
Sharing Your Mail Folders ................................................................................................................. 42

▼ To Share One of Your Mail Folders ........................................................................................... 42
Subscribing to a Shared Mail Folder .................................................................................................. 43

▼ To Subscribe to a Shared Mail Folder ........................................................................................ 43
Unsubscribing from a Shared Mail Folder ....................................................................................... 43

▼ To Unsubscribe from a Shared Mail Folder .............................................................................. 43

Contents

Sun Java System Connector for Microsoft Outlook 7.2 User's Guide • March 20074



Working Offline ................................................................................................................................... 44
Setting the Offline and Online Mode ......................................................................................... 44

▼ To Work Offline ................................................................................................................... 44
▼ To Return to Online Mode .................................................................................................. 44

Selecting a Folder for Offline Use ............................................................................................... 44
▼ To Select a Folder for Offline User ...................................................................................... 45

Changing the Folder Class .................................................................................................................. 45
▼ To Change the Folder Class ........................................................................................................ 45

Synchronizing Folders ........................................................................................................................ 46
▼ To Synchronize a Single Mail Folder ......................................................................................... 46

Setting Up an Out of Office Message ................................................................................................. 46
▼ To Set Up Your Out of Office Message ...................................................................................... 46

Setting Up Server-Side Mail Filters ................................................................................................... 47
▼ To Apply Server-Side Filters to Mail Folders ............................................................................ 47

6 Working with Calendar Folders .........................................................................................................49
Accessing Your Calendar ................................................................................................................... 49
Sharing Your Calendar ....................................................................................................................... 49

▼ To Share Your Calendar .............................................................................................................. 50
Subscribing to a Shared Calendar ...................................................................................................... 50

▼ To Subscribe to a Shared Calendar ............................................................................................ 50
Unsubscribing From a Shared Calendar .......................................................................................... 51

▼ To Unsubscribe From a Shared Calendar ................................................................................. 51
Synchronizing Folders ........................................................................................................................ 51

▼ To Synchronize a Single Calendar Folder ................................................................................. 52
Creating Multiple Calendars .............................................................................................................. 52

▼ To Create a New Calendar Folder .............................................................................................. 52

7 Working with the Contacts Folder .................................................................................................... 55
Accessing Your Contacts .................................................................................................................... 55
Sharing Your Contacts Folder ........................................................................................................... 55

▼ To Delegate Access to Your Contacts Folder ............................................................................ 56
Subscribing to Shared Contacts Folders ........................................................................................... 56

▼ To Subscribe to Another User's Contacts Folder ..................................................................... 56
Unsubscribing From Shared Contacts .............................................................................................. 57

Contents

5



▼ To Unsubscribe From a Shared Contact List ............................................................................ 57
Adding Shared Contacts Folders to Select Names Dialog .............................................................. 57

▼ To Add a Shared Contact Folder to the Select Names Dialog ................................................. 57
Removing Shared Contacts Folders from Select Names Dialog .................................................... 58
Creating Multiple Contacts Folders .................................................................................................. 59

▼ To Create a New Contact Folder ................................................................................................ 59

8 Troubleshooting ..................................................................................................................................61
If Microsoft Outlook Is Not Your Default Email Client ................................................................. 61

▼ To Set Outlook as Your Default Mail Client ............................................................................. 61
If a Sun Synchronization Program Is Installed, and Must Be Removed ........................................ 62

▼ To Remove the Synchronization Program ............................................................................... 62
If a Personal Folder (.pst) File Conversion Is Interrupted .............................................................. 63
Logging ................................................................................................................................................. 64

Enabling Logging for Troubleshooting ..................................................................................... 64
▼ To Enable Logging ................................................................................................................ 64

Sending a Log Report ................................................................................................................... 65
▼ To Send a Log Report ........................................................................................................... 65

Increasing Log Files and Size ...................................................................................................... 65
Assigning Tasks ................................................................................................................................... 66
If a Server is Down ............................................................................................................................... 66
Viewing Message Source .................................................................................................................... 66

▼ To View the Message Source ...................................................................................................... 66
Losing Connection Due to Timeout ................................................................................................. 67
Repairing Errors in the .pst File ......................................................................................................... 67

Locating the .pst File .................................................................................................................... 67
▼ To Find the Current .pst File ............................................................................................... 67

Repairing the .pst File with the Inbox Repair Tool .................................................................. 67
▼ To Run the Inbox Repair Tool ............................................................................................ 68

Index ......................................................................................................................................................69

Contents

Sun Java System Connector for Microsoft Outlook 7.2 User's Guide • March 20076



Figures

FIGURE 2–1 Folder Hierarchies for Migrated Data ..................................................................... 19
FIGURE 2–2 Setup Wizard: Welcome Screen ............................................................................... 20
FIGURE 2–3 Setup Wizard: Checking for Minimum Installation Requirements .................... 21
FIGURE 2–4 Setup Wizard: Select Outlook User Profile to Convert ......................................... 22
FIGURE 2–5 Setup Wizard: Select Personal Folders (.pst) Files to Convert ............................. 24
FIGURE 2–6 Setup Wizard: Enter Microsoft Exchange Mailbox Information ........................ 25
FIGURE 2–7 Setup Wizard: Enter Microsoft Exchange Mailbox Information ........................ 26
FIGURE 2–8 Setup Wizard: Enter Personal Folders (.pst) File Password .................................. 27
FIGURE 2–9 Setup Wizard: Converting User Profile (Progress Meter) .................................... 28
FIGURE 2–10 Setup Wizard: Finishing PST as a Background Process ........................................ 29
FIGURE 2–11 Setup Wizard: Completing the Setup ...................................................................... 30
FIGURE 2–12 Setup Wizard: Setup Failed ...................................................................................... 30
FIGURE 8–1 To Finish an Aborted Conversion: The Desktop “Finish” Icon ........................... 63
FIGURE 8–2 Setup Wizard Welcome Screen, to Resume an Interrupted Conversion ............ 64

7



8



Preface

This User's Guide explains how to use the Setup Wizard to install and configure the Sun JavaTM

System Connector for Microsoft Outlook on your desktop. This guide also describes how to use
the Connector for Microsoft Outlook through the user interface.

The Sun Java System Connector for Microsoft Outlook will let you and your coworkers use
Microsoft Outlook as your email and calendar application while connected to Sun Java System
servers. The Connector software performs necessary ongoing communications between
Outlook and the Sun Java System server, so that you will have access to your new mailbox and
full use of your calendar, address book, and other Outlook features.

Who Should Use This Book
You should read this book if you plan to install and use Sun Java System Connector for
Microsoft Outlook on your desktop.

Before You Read This Book
This book assumes that you are responsible for installing the Connector for Microsoft Outlook
software on your desktop and that you have a general understanding of the following:

■ The Internet and the World Wide Web
■ Installing software on the following platforms:

■ Microsoft Windows 2000
■ Microsoft Windows XP

■ Microsoft Outlook

9



How This Book Is Organized
This book contains the following chapters:

Chapter 1 provides an overview of Connector for Microsoft Outlook.

Chapter 2 describes how to install Connector for Microsoft Outlook on your desktop.

Chapter 3 describes how to get started using Connector for Microsoft Outlook.

Chapter 4 describes how to set up Outlook properties to work with Sun Java System servers.

Chapter 5 describes how to work with email folders.

Chapter 6 describes how to work with calendar folders.

Chapter 7 describes how to work with contacts.

Chapter 8 provides troubleshooting tips when using Connector for Microsoft Outlook.

Connector for Microsoft Outlook Documentation Set
The following table summarizes the books included in the Connector for Microsoft Outlook
core documentation set.

TABLE P–1 Books in This Documentation Set

Book Title Description

Part VI, “Deploying Connector for Microsoft
Outlook,” in Sun Java Communications Suite 5
Deployment Planning Guide

Describes the administrator’s process and strategies for
deploying Connector for Microsoft Outlook to user
desktops.

Sun Java System Connector for Microsoft
Outlook 7.2 Installation Guide

Describes how to install the administration software that
helps an administrator deploy Connector for Microsoft
Outlook to user desktops.

Sun Java System Connector for Microsoft
Outlook 7.2 Administration Guide

Describes the administrator’s deployment configuration
program for the Connector for Microsoft Outlook.

Sun Java System Connector for Microsoft
Outlook 7.2 User’s Guide

(This guide) Explains how to install, use and configure the
Connector for Microsoft Outlook on your desktop. This
guide also describes the user interface.

Sun Java Communications Suite 5 Release Notes Contains last-minute information, including a
description of what is new in this current release, known
problems and limitations, installation notes, and how to
report issues with the software or the documentation.

Preface
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The Connector for Microsoft Outlook documentation collection can be found at
http://docs.sun.com/coll/1630.1.

Related Books
For other server documentation, go to the following:

■ Sun Java System Messaging Server documentation (http://docs.sun.com/coll/1312.2)
■ Sun Java System Calendar Server documentation (http://docs.sun.com/coll/1313.2)

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–2 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and directories,
and onscreen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 A placeholder to be replaced with a real name or
value

The command to remove a file is rm
filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized (note that some emphasized items
appear bold online)

Read Chapter 6 in the User's Guide.

A cache is a copy that is stored
locally.

Do not save the file.

Shell Prompts in Command Examples
The following table shows default system prompts and superuser prompts.

Preface
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TABLE P–3 Shell Prompts

Shell Prompt

C shell on UNIX and Linux systems machine_name%

C shell superuser on UNIX and Linux systems machine_name#

Bourne shell and Korn shell on UNIX and Linux systems $

Bourne shell and Korn shell superuser on UNIX and Linux systems #

Microsoft Windows command line C:\

Symbol Conventions
The following table explains symbols that might be used in this book.

TABLE P–4 Symbol Conventions

Symbol Description Example Meaning

[ ] Contains optional
arguments and command
options.

ls [-l] The -l option is not required.

{ | } Contains a set of choices for
a required command option.

-d {y|n} The -d option requires that you use
either the y argument or the n
argument.

${ } Indicates a variable
reference.

${com.sun.javaRoot} References the value of the
com.sun.javaRoot variable.

- Joins simultaneous multiple
keystrokes.

Control-A Press the Control key while you press
the A key.

+ Joins consecutive multiple
keystrokes.

Ctrl+A+N Press the Control key, release it, and
then press the subsequent keys.

→ Indicates menu item
selection in a graphical user
interface.

File → New → Templates From the File menu, choose New.
From the New submenu, choose
Templates.

Preface
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Documentation, Support, and Training
The Sun web site provides information about the following additional resources:

■ Documentation (http://www.sun.com/documentation/)
■ Support (http://www.sun.com/support/)
■ Training (http://www.sun.com/training/)

Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related information.

Note – Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content, advertising,
products, or other materials that are available on or through such sites or resources. Sun will not
be responsible or liable for any actual or alleged damage or loss caused or alleged to be caused by
or in connection with use of or reliance on any such content, goods, or services that are available
on or through such sites or resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Send Comments.
In the online form, provide the full document title and part number. The part number is a
7-digit or 9-digit number that can be found on the book's title page or in the document's URL.
For example, the part number of this book is 819-4411.

Preface
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Sun Java System Connector for Microsoft
Outlook Overview

Sun Java System Connector for Microsoft Outlook enables Sun Java Enterprise System features
and functionality to be available through Microsoft Outlook.

The following topics are discussed in this chapter:

■ “What is Sun Java System Connector for Microsoft Outlook?” on page 15
■ “Where to Find Other Information” on page 16

What is Sun Java System Connector for Microsoft Outlook?
Sun Java System Connector for Microsoft Outlook enables Outlook to be used as a desktop
client with Sun Java Enterprise System.

Connector for Microsoft Outlook is an Outlook plug-in that must be installed on the end-user’s
desktop. Connector for Microsoft Outlook queries the Sun Java System Messaging Server for
folder hierarchies and email messages. It converts the information into Messaging API (MAPI)
properties that Outlook can display. Similarly, it uses WCAP to query the Sun Java System
Calendar Server for events and tasks which are then converted into MAPI properties.

When users create and modify items through Outlook, Connector for Microsoft Outlook passes
the new message along to the appropriate server depending on its message type. It sends new
outgoing email to an SMTP mail server for delivery, and sends modified email messages back to
the user’s IMAP folder for storage. New calendar events and tasks are converted into a standard
format to be stored in the Calendar Server database.

Sun Java System Connector for Microsoft Outlook 7.2 includes support for address book
service. This service makes use of WABP and allows a user to have their personal address book
accessible from both Outlook and Sun Java System Communications Express. In addition, users
have access to a corporate directory in conjunction with contacts and the user's personal
address book.

1C H A P T E R 1
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Where to Find Other Information
The Sun Java System Connector for Microsoft Outlook documentation collection can be found
at http://docs.sun.com/coll/1630.1.

■ Sun Java Communications Suite 5 Release Notes describes features, known limitations and
problems, system requirements, and other important information about this release of Sun
Java System Connector for Microsoft Outlook.

■ Sun Java System Connector for Microsoft Outlook 7.2 Installation Guide describes how to
install the administration software that helps an administrator deploy Connector for
Microsoft Outlook to user desktops.

■ Part VI, “Deploying Connector for Microsoft Outlook,” in Sun Java Communications Suite 5
Deployment Planning Guide describes the administrator’s process and strategies for
deploying Connector for Microsoft Outlook to user desktops.

■ Sun Java System Connector for Microsoft Outlook 7.2 Administration Guide describes the
Desktop Deployment Configuration Program, which allows the administrator to create
custom end-user installation packages that configures and customizes the software per the
administrator’s specifications.

■ Sun Java System Connector for Microsoft Outlook 7.2 User's Guide (this book) describes how
to use the Setup Wizard to install and configure Sun Java System Connector for Microsoft
Outlook on a user’s desktop. Also describes the user interface for Connector for Microsoft
Outlook.

Where to Find Other Information

Sun Java System Connector for Microsoft Outlook 7.2 User's Guide • March 200716
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Installing and Configuring the Software on Your
Desktop

The Sun Java System Connector for Microsoft Outlook software must be installed and
configured on every user's desktop, but after it's installed it will become virtually invisible to
you. It will operate automatically, in the background, and will require no maintenance
whatsoever.

The system administrator of your network has prepared a special installation package for you,
called the Setup Wizard, to install and configure the Sun Java System Connector for Microsoft
Outlook on your desktop. These installation packages are designed to simplify and automate
the installation process, to spare you much of the time and hassle of having to enter technical
information and make technical choices by yourself. Your Setup Wizard also contains a
conversion program that can automatically convert any existing Outlook data stored on your
desktop— your old messages, address books, contacts, calendar data and so forth— to the new
format that the Connector for Microsoft Outlook software can use.

About the Setup Procedure
The procedure to install the Sun Java System Connector for Microsoft Outlook on your desktop
may follow any of several different paths, depending on your current system setup, the volume
of data (if any) that you want to convert from the old Outlook format to the new format, and
other factors. This guide explains all of the screen displays that may appear to various users, but
it's a rare case that any single user would see them all, and the ones that don't apply to you will
be skipped.

System Requirements
The Sun Java System Connector for Microsoft Outlook requires:

■ Operating System: Windows 2000 (Service Pack 3 or higher) or Windows XP (Service Pack
1 or higher). The Setup Wizard will not start under any other operating system.

2C H A P T E R 2
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■ Your default email client must be one of these versions of Microsoft Outlook:
■ Outlook 2003 and Outlook 2003 SP2.
■ Outlook 2002 with Office XP Service Pack 2 or higher.
■ Outlook 2000 in Corporate Mode (not in Internet Mode), with Office 2000 Service Pack

3 or higher.

Profiles that May Be Converted
The Setup Wizard can convert the following profile types to Outlook profiles that work with the
new Sun Java System Connector:

■ Exchange profiles, and POP profiles
■ IMAP profiles from Outlook 2002/XP and Outlook 2003 (but not from Outlook 2000, where

IMAP profiles cannot exist in Corporate Mode)
■ Sun Java System Connector profiles earlier than version 7.2 from Outlook 2000 and Outlook

2002/XP (but not from Outlook 2003) can be upgraded toConnector for Microsoft Outlook
7.2

Folder Hierarchies for Migrated Data
The Sun server supports only one top-level folder within Outlook for each type of data—
Contacts, Notes, Calendar, Tasks or Journal. If the source folder hierarchy contains more than
one top-level folder for any one data type (as shown inFigure 2–1 below), only the primary
(first-listed) folder appears in the top level after the migration. The other folders of the same
data type are migrated to a new second-level folder named My [DataType], also shown in Figure
2–1.

About the Setup Procedure
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If a Large PST File Conversion Is Interrupted
If the conversion of a large file is interrupted before its completion (by a power failure, for
example), the Setup Wizard offers a Recovery feature that lets you complete a conversion in
progress rather than having to start over from scratch. If this should happen to you, please see
“If a Personal Folder (.pst) File Conversion Is Interrupted” on page 63.

The Setup Procedure
This section describes the steps to follow in order to install and configure Sun Java System
Connector for Microsoft Outlook on your desktop.

Step 1: Starting the Setup Wizard
Your network administrator will tell you how to start your Sun Java System Connector for
Microsoft Outlook Setup Wizard—most likely by finding the program name through your Start

Contacts

Subcontacts

Other Contacts

Tasks

Subtasks

More Tasks

Notes

Other Notes

Contacts

Sun Java SystemSource System

Subcontacts

My Contacts

Other Contacts

Tasks

Subtasks

My Tasks

More Tasks

Notes

My Notes

Other Notes

FIGURE 2–1 Folder Hierarchies for Migrated Data

The Setup Procedure
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button, or by an icon on your desktop, or by browsing to a particular location in your network.
But no matter how you start the Setup Wizard, the procedure begins with the display of the
Welcome screen shown in Figure 2–2.

▼ To Start the Setup Wizard

Read the Welcome message, and click the Next button.
The Setup Wizard then examines your system to verify the following:

■ Microsoft Outlook is designated as your default email client, and your version of Outlook is
supported by this Connector software.

■ The Sun Java System Synchronization program (previously known as the Sun ONE Sync
program), which is incompatible with this Connector software, is not installed.

If Outlook is not set as your default email client, or if an incompatible Sun synchronization
program is installed, the Wizard notifies you and prompts you to acknowledge the notice and
exit the program. (You will be able to run this Setup Wizard again after you correct the
problem.) To resolve either of these problems, see the instructions in Chapter 8 under:

■ “If Microsoft Outlook Is Not Your Default Email Client” on page 61
■ “If a Sun Synchronization Program Is Installed, and Must Be Removed” on page 62

Similarly, if your version of Outlook is not supported, the Wizard notifies you of the problem
and prompts you to exit the program, and you may rerun the Setup Wizard after you upgrade to
a supported version of Outlook.

Otherwise, if a supported version of Outlook is set to be your default email client, and if no Sun
synchronization program is installed: The Setup Wizard copies the necessary files to your

FIGURE 2–2 Setup Wizard: Welcome Screen

1
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computer, and examines your system to see whether the Microsoft Web Publishing Wizard
(WPW) is installed. The WPW is a component that lets you share your free/busy schedule with
coworkers.

Determine whether or not Microsoft Web Publishing Wizard is already installed.

■ If WPW is already installed: The Wizard moves on to the next phase of this installation and
setup process. Skip ahead to“Step 3: Selecting an Outlook User Profile to Convert” on
page 22 .

■ If WPW is not installed: The Setup Wizard prompts you to install it now. Go on to “Step 2:
Installing Microsoft Web Publishing Wizard” on page 21.

Step 2: Installing Microsoft Web Publishing Wizard
This screen will not appear (and you may skip this step) if the Setup Wizard finds the Microsoft
Web Publishing Wizard (WPW) already installed on your computer. If, however, WPW is not
installed on your computer, you should install it now.

Your system administrator has previously specified the file name and location (path) of an
installable copy of WPW in your network, and the Setup Wizard displays that information here,
as shown in Figure 2–3.

▼ To Install Microsoft Web Publishing Wizard

Click Next.
The Setup Wizard then displays the WPW License Agreement for you to read and accept or
decline.

FIGURE 2–3 Setup Wizard: Checking for Minimum Installation Requirements
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Read the entire License Agreement, and click either Yes or No to indicate whether you accept or
decline its terms.

If you answer Yes: The installation kit installs WPW on your computer, and the Setup Wizard
moves on to the next phase of the installation process. Go on to “Step 3: Selecting an Outlook
User Profile to Convert” on page 22.

If you answer No: The installation kit does not install WPW on your computer, and the Setup
Wizard aborts the entire Sun Java System Connector installation process. (The Setup Wizard
will install WPW and proceed with the installation only if you accept the WPW License
Agreement by clicking the Yes button.)

Step 3: Selecting an Outlook User Profile to Convert
The screen shown in Figure 2–4appears only if your administrator has configured your Setup
Wizard to convert an existing profile, and if the Setup Wizard finds one of the following:

■ Two or more eligible Outlook user profiles connecting to Exchange server(s) on your
computer.

■ Only one eligible profile that is not set as your default.

An “eligible” profile is any Outlook profile that:

■ Includes message services of at least one type previously designated by your mail
administrator (e.g., Microsoft Exchange, MS POP, MS IMAP, or an earlier version of the Sun
Java System Connector).

■ Is not yet fully converted (all of its .pst files converted) by a previous run of this Setup
Wizard.

FIGURE 2–4 Setup Wizard: Select Outlook User Profile to Convert
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If the Wizard finds only one eligible user profile, and the profile is designated as your default
profile, the Wizard will skip this screen on the assumption that you want to convert the one
eligible profile for the new software. Skip ahead to “Step 4: Selecting Personal Folders (.pst) Files
to Convert” on page 23.

Similarly, if the Wizard finds no eligible user profile to convert and your administrator has
configured the Wizard to create a new user profile in that case, this step 3 does not apply to
you— in fact, you can skip steps 4 and 5 too, and resume at “Step 6: Entering New Account
Login Information” on page 26.

▼ To Select a Profile for Conversion
This screen prompts you to select a single Outlook user profile to convert for use with the new
Sun Java System Connector software. It is very similar to the dialog box you likely see when you
start Outlook.

Use the drop-down list box to select the profile you want to convert.

Click Next.

You may use the Setup Wizard to convert more than one profile, but only one at a time. You
must run the Setup Wizard again for each profile you want to convert.

When you click Next, the Setup Wizard finds all of the Personal Folders (.pst) files associated
with the user profile you have selected. Go on to “Step 4: Selecting Personal Folders (.pst) Files
to Convert” on page 23.

Step 4: Selecting Personal Folders (.pst) Files to
Convert
This screen appears only if you are converting an Exchange profile, and if the Setup Wizard
finds one or more “large” .pst files (exceeding a size limit specified earlier by your mail
administrator). If you are converting a POP or IMAP profile, or are upgrading to Sun Java
System Connector for Microsoft Outlook 7.2 from a previous version, you may skip this step
and the next, and resume at “Step 6: Entering New Account Login Information” on page 26
below.

For current Exchange users, the Setup Wizard can convert Contacts, Journal and Notes data
from the Exchange server to the Sun Java System Connector profile. The Wizard will
automatically convert any .pst files if finds on your desktop that do not exceed the size limit
specified by your administrator. If none of your .pst files is “large,” the Setup Wizard simply
converts all of your .pst files, and you may skip ahead to “Step 5: Entering Exchange Account
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Login Information” on page 25. But if the Wizard finds one or more “large” .pst files, the
program asks you to specify which files (if any) you want to convert at this time, as shown in
Figure 2–5.

The Setup Wizard will convert only those files that are checkmarked in the boxes to the left of
the corresponding file names. The displayed list may also include one or more smaller .pst
files, automatically checkmarked for conversion and grayed out (so that you cannot unmark
them).

The Wizard converts these files to make the mail addresses “live.” Unconverted email messages
would still be readable, but you would be unable to reply to them because the unconverted
addresses would be in a form that is unfamiliar to your new server. On the other hand,
converting large volumes of old messages can take a long time, even several hours if your
personal stores happen to run into gigabytes of data. The conversions can run in the
background, freeing you and your computer for other work, but it may slow the performance of
your other applications. For this reason, if you have some personal stores that are very old, so
that the need for a future reply is highly unlikely although you'd like to be able to keep and read
the data, you can elect to not convert it. Another option is simply to defer the conversion of
larger files to a later time, such as during a lunch break or even overnight.

▼ To Select the .pst Files to Convert

Verify that all the files you want to convert now are marked, and that the files you do not want to
convert are not marked.
To add or remove a checkmark, simply click in the box.

FIGURE 2–5 Setup Wizard: Select Personal Folders (.pst) Files to Convert
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Click Next.
The Wizard then prompts you to provide your personal login information for your old
Microsoft Exchange mailbox. Go on to “Step 5: Entering Exchange Account Login
Information” on page 25 .

Step 5: Entering Exchange Account Login Information
The screen shown inFigure 2–6 appears only if you have previously used Outlook on this
computer, and your system is configured to prompt you for this information when you login to
use the selected user profile. If you are a new email user who does not have an existing account
on the Exchange server, or if your system is configured to not require this information when
you log in, this screen will not appear and you may skip ahead to “Step 6: Entering New Account
Login Information” on page 26.

▼ To Enter the Requested Information for Your Microsoft Exchange
Mailbox

Enter your User name: the Windows account name associated with your Exchange mailbox.

Enter your Domain: the domain in which your Windows account resides.

Enter your Password: the password for your Windows account.

Click the Next button.
The Setup Wizard then prompts you to provide your personal login information for your new
Sun Java System account. Go on to “Step 6: Entering New Account Login Information” on
page 26.

FIGURE 2–6 Setup Wizard: Enter Microsoft Exchange Mailbox Information

2

1

2

3

4

The Setup Procedure

Chapter 2 • Installing and Configuring the Software on Your Desktop 25



Step 6: Entering New Account Login Information
This screen, shown in Figure 2–7, appears as part of the Setup procedure for all users, to request
your login credentials for the new Sun Java System server.

Some of the fields in this screen may appear grayed out if your network administrator has
already entered this information for you. Similarly, the Save user name and password
checkbox will not appear if your administrator has pre-configured your software to always or
never require this information upon login to Outlook.

▼ To Enter the Requested Information for Your New Account

Enter your Full name: the name that appears in the From field of your outgoing mail messages.
This is the“friendly”name displayed to the recipients of your messages.

Enter your Email address: your Internet email address.

Enter your User name: your account name.

Enter your Password: the password for your Sun Java System accounts.

If the Save user name and password checkbox appears in this screen: Check or uncheck the
option to indicate whether you want to be able to start Outlook without being prompted for
this login information every time.

Click the Next button.

FIGURE 2–7 Setup Wizard: Enter Microsoft Exchange Mailbox Information
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The Setup Wizard then checks to see if any of the Personal Folders ( .pst) files scheduled for
conversion are password-protected. Go on to “Step 7: Entering Passwords for Protected
Personal Folders” on page 27.

Step 7: Entering Passwords for Protected Personal
Folders
The screen shown in Figure 2–8 appears in the Setup procedure if any of the Personal Folders
(.pst) files you have selected for conversion are protected by a password, and the password is
not saved in the password list. The screen reappears for each password-protected .pst file that
is scheduled for conversion. If none of your .pst files is password-protected, or if all of the files'
passwords are saved in the password list, the Setup Wizard simply begins converting the
selected user profile and .pst file(s), and you may skip ahead to “Step 8: Monitoring the
Progress Meter” on page 28.

▼ To Enter the Personal Folders (.pst) File Password
The screen displays the name, size and location (path) of a password-protected Personal Folders
file (.pst file), and prompts you for the password that is required to open the file.

Enter the password associated with the named .pstfile.

Click Next.

When you have entered the password for the last .pst file that requires a password, the Setup
Wizard then begins converting the user profile. Go on to “Step 8: Monitoring the Progress
Meter” on page 28.

FIGURE 2–8 Setup Wizard: Enter Personal Folders (.pst) File Password
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Step 8: Monitoring the Progress Meter
The screen shown inFigure 2–9 illustrates the Wizard's progress as it converts the selected user
profile and the “small” Personal Folders (.pst) files, and copies some data (Contacts, Notes and
Journals) from your Exchange server to a local store, so you will have access to this data when
you start using Outlook with your new Sun Java System server.

When these processes are complete:

■ If no “large” Personal Folders (.pst) files are being converted: The Wizard simply displays a
notification screen to let you know its work is finished. Go on to “Step 9: Exiting” on
page 29.

■ If any “large” Personal Folders (.pst) files are being converted: The Wizard notifies you that
the profile conversion is complete, and prompts you to begin converting the large Personal
Folders files, as shown in Figure 2–10.

FIGURE 2–9 Setup Wizard: Converting User Profile (Progress Meter)
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▼ To Begin Converting Large Personal Folders Files

Click Next.
The Setup Wizard then minimizes itself to your Task Bar, to run the conversion(s) in the
background. Since the profile conversion is already complete, you may immediately begin using
Outlook with the new Sun Java System server, even as the Wizard continues to convert your
larger Personal Folders files. The large-file Personal Folders conversion(s) may proceed for
several minutes, or even hours, depending on the size of the file(s) being converted.

The Wizard automatically displays a notification screen when the conversion is finished. Go on
to “Step 9: Exiting” on page 29.

▼ To View a Progress Meter in Real Time

Restore the Setup Wizard from the Task Bar to its display window.

The Wizard automatically displays a notification screen when the conversion is finished. Go on
to “Step 9: Exiting” on page 29.

Step 9: Exiting
The contents of this Exit screen will vary depending on whether the Setup Wizard has
successfully installed the Sun Java System Connector for Microsoft Outlook. The title of the
screen reports success or failure.

FIGURE 2–10 Setup Wizard: Finishing PST as a Background Process
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Setup Process Completes
This screen (e.g., Figure 2–11) simply reports the successful completion of the conversion(s)
and of the overall Setup process. Just click the Exit button to clear this screen and close the Setup
Wizard. Congratulations! Your Sun Java System Connector for Microsoft Outlook Setup
procedure is now complete, and you may now begin using Outlook with the new Sun Java
System server.

Setup Process Fails
The Setup Wizard has abandoned the installation process, and the text in this screen will
explain why. When the Setup fails, this screen (Figure 2–12) offers a View Log button that will
display the contents of the program’s log file, which may offer additional clues to help you
diagnose a problem.

A Setup failure will be due to one of these four problems:

FIGURE 2–11 Setup Wizard: Completing the Setup

FIGURE 2–12 Setup Wizard: Setup Failed
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■ Microsoft Outlook is not set as your default email client. For more information and
instructions to correct this problem, see “If Microsoft Outlook Is Not Your Default Email
Client” on page 61 in Chapter 6 of this User’s Guide.

■ The Setup Wizard has detected the presence of an incompatible Sun synchronization
program on your computer. For more information and instructions to correct this
problem, see “If a Sun Synchronization Program Is Installed, and Must Be Removed” on
page 62.

■ You are running a version of Microsoft Outlook or an associated Office Service Pack that
is incompatible with the Connector software. For more information about this problem,
see “System Requirements” on page 17 near the beginning of this Chapter 2.

■ You have declined the License Agreement for Microsoft’s Web Publishing Wizard
(WPW), which is a required accessory for the Sun Java System Connector for Microsoft
Outlook. The Setup Wizard will not install the Connector software without the WPW, and
it will not install the WPW without your acceptance of the License Agreement.

■ Outlook is currently running on your desktop. Exit Outlook and then select the
cancel/retry button on the installation dialog (or exit and restart the installation).

■ The DLLs for Connector for Microsoft Outlook are not compatible with the current
Deployment Configuration Program (7.1.221.0), or the DLLs do not support Global
Address Book (GAL). Make sure that the "Install or upgrade Sun Java System Connector for
Microsoft Outlook" option is selected before creating or modifying a profile so that the
DLLs are also upgraded.

■ Microsoft XML Parser (MSXML3) is not installed on the user's desktop. This can be
downloaded from http://msdn.microsoft.com/XML/XMLDownloads/.

■ The user does not have administrative privileges to the system.

Regardless of whether the Setup Wizard successfully completed the installation: Click the Exit
button to clear this screen and close the Setup Wizard.

The Setup Procedure
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Getting Started

Once Sun Java System Connector for Microsoft Outlook is installed and configured on your
desktop, you can open Outlook and begin using Connector for Microsoft Outlook. This section
describes the initial settings and appearance, and also some of the typical getting started tasks.

The following topics are discussed in this chapter:

■ “Starting Outlook” on page 33
■ “What You See” on page 33
■ “Typical Initial Profile” on page 34
■ “Accessing Your Inbox” on page 34
■ “Accessing Your Calendar” on page 34
■ “Accessing Your Contacts” on page 34

Starting Outlook
When you first start Outlook, you may be asked which profile to use. Select the Connector for
Microsoft Outlook profile that you created during installation and click OK.

What You See
When Outlook opens, you see:

■ Outlook Shortcuts: Outlook Today, Inbox, Calendar, Contacts, Tasks, Notes, and Deleted
Items.

■ Folders List
The Folders List is made up of the following:
■ Your mail Inbox and other mail folders in your specified mail server.
■ Your Calendar, Tasks, and Shared Calendars which are stored on the calendar server.
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■ Your Contacts are stored on the address book server.
■ Your Outbox which is a local folder used for sending mail.

Typical Initial Profile
The Sun Java System Connector for Microsoft Outlook software that is installed on the client
enables server-side features and functionality available through the user interface. A typical
Connector for Microsoft Outlook profile consists of:

■ Mail — the information store for incoming mail (IMAP) and SMTP transport for outgoing
mail.

■ Calendar — the information store for calendar data.
■ Address Book — the information store for contacts.

Accessing Your Inbox
You can access your email Inbox on the Sun Java System Messaging Server using one of the
following methods:

■ Select the Inbox subfolder under Folders - your name.
■ In the Outlook Today view, select Inbox under the Messages category.
■ Click Inbox under the Outlook Shortcuts view.

Accessing Your Calendar
You can access your default calendar on the Sun Java System Calendar Server using one of the
following methods:

■ Select the Calendar subfolder under Folders - your name.
■ In the Outlook Today view, select Calendar.
■ Select Calendar under the Outlook Shortcuts view.

Accessing Your Contacts
You can access your contacts on the Sun Java System Address Book Server using one of the
following methods:

■ Select Contacts under Folders - your name.
■ Select Contacts under the Outlook Shortcuts view.

Typical Initial Profile
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Configuring Connector for Microsoft Outlook

This section describes how to set up your Outlook properties to work with Sun Java System
Connector for Microsoft Outlook and the servers for mail, calendar, and address book.

The following topics are discussed in this chapter:

■ “Configuring Servers and User Accounts” on page 35
■ “Configuring Mail Properties” on page 36
■ “Configuring Calendar Properties” on page 38
■ “Configuring Address Book Properties” on page 38
■ “Configuring Global Address List Properties” on page 39
■ “Configuring Store and Logging Properties” on page 39

Configuring Servers and User Accounts
Your initial server and user account settings should be configured when you set up your profile
with the Deployment Configuration Program.

▼ To Change the Initial Configuration Settings
Exit Outlook.

Open the Control Panel and double-click the Mail icon.

In the Services tab, choose Folders - your name and click Properties.
The Sun Java System Connector for Microsoft Outlook properties dialog appears. Make sure
the Sun Java Enterprise System tab is selected.

a. Within this tab, you can change the servers and settings for the following Sun Java System
servers:
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■ Incoming Mail — name and port number of the Messaging Server on which you receive
incoming mail. The default port number is 143.

■ Outgoing Mail — the name and the port number of the Messaging Server via which to
send messages using the SMTP protocol. The default port number is 25.

■ Calendar — name of the server and the port number on which the Calendar Server is
running. The default port number is 80.

■ Address Book — name and the port number on which the Address Book Server is
running. This is where your Contacts are stored. The default port number is 80.

■ Global Address List — name and port number on which the corporate directory is
located. The default port number is 389.

If the SSL checkbox is enabled for any of the above servers, an SSL connection will be
attempted, using the port specified in Port.

b. You can configure the following user settings within the Sun Java Enterprise System tab:

■ Full Name — a readable form of your name. It is used to add descriptive information to
your email address when generating and sending mail messages.

■ User Name — your userID that the servers use to access your information.
■ Password — your password. Enable the Remember Password checkbox if you wish to

have an encrypted form of your password saved into the local registry. If not checked,
the password is not saved, and you are always prompted for the password when
initiating a client session.

■ Email Address — your email address. This is the address placed in a message's From:
header, if the composed message does not have a from field to override it. It is often used
to identify the return address when the receiver of a message needs to generate replies,
receipts, notifications, and so on.

When you are finished making changes, click OK.

Configuring Mail Properties

▼ To Change Mail Properties
In the Folders List, right-click Folders - your name.

In the pop-up menu, select Properties for Folders - your name.

In the Mail Folder Properties window, click the Advanced button.
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In the Sun Java System Connector for Microsoft Outlook properties dialog, select the Mail tab.
Within this tab, you can change the properties for incoming mail (IMAP) and outgoing mail
(SMTP):

■ Synchronize Mail folders every x minutes — the interval after which a server mailbox may
be polled for any recently-arrived messages. If any new messages arrive, the mailbox is
refreshed and redisplayed. This value defaults to 5 minutes. A minimum frequency of 1
minute is enforced. If this field is cleared or set to zero, no polling will be performed for this
server connection.

■ Enable polling for all folders — enable this checkbox if you want Connector for Microsoft
Outlookto poll all folders, including your Inbox, for unread messages. The default, if this
checkbox is not enabled, is to poll only your Inbox. This option can be useful if you have set
up filters that automatically move incoming messages to specific folders other than your
Inbox, or if you have enabled the direct delivery to folder option (see “Sharing Your Mail
Folders” on page 42“Sharing Your Mail Folders” on page 42 for a description of this
option).

■ Offline settings
■ Download messages — If this option is enabled all messages in folders that have been

selected for offline use are downloaded into the local cache when working in offline
mode. See “Working Offline” on page 44 for instructions on how to work offline. See
“Selecting a Folder for Offline Use” on page 44 for instructions on how to select a folder
for offline use. By default your Inbox is downloaded.

■ Do not download messages if they are larger than X KB — If this option is enabled,
only messages that are smaller than the value entered into the field are downloaded into
the local cache when working in offline mode. This field is primarily intended to reduce
download times when going into offline mode.

■ Server requires Authentication — if this checkbox is enabled, SMTP authentication is
required for sending mail.

■ Use Alternate Account — if this checkbox is enabled, the SMTP server uses the provided
User Name and User Password for SMTP AUTH authentication. If the checkbox is not
enabled, it is defaulted to Sender's email Address.

■ Send BCC to sender’s E-mail address — if this checkbox is enabled, any email that is sent
will have the email address in the BCC. This effectively provides a way for senders to file a
copy of all messages they send. The messages are filed within a sender's server INBOX, and
will be subsequently affected by any server-based message filtering rules.

When you are finished making changes, click OK.
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Configuring Calendar Properties

▼ To Change Calendar Properties
In the Folders List, right-click Folders - your name.

In the pop-up menu, select Properties for Folders - your name.

In the Mail Folder Properties window, click the Advanced button.

In the Sun Java System Connector for Microsoft Outlook properties dialog, select the Calendar
tab.
Within this tab you can change the following Calendar properties:
■ Synchronize Every x minutes— the amount of time you want Outlook to sync information

with the Calendar Server.
■ Use Alternate User account — if this checkbox is enabled, Calendar Server uses an

alternate user account than the account specified under the Sun Java Enterprise System tab.
Enter the User Name and User Password for this alternate Calendar Server account in the
appropriate fields.

When you are finished making changes, click OK.

Configuring Address Book Properties

▼ To Change Address Book Properties
In the Folders List, right-click Folders - your name.

In the pop-up menu, select Properties for Folders - your name.

In the Mail Folder Properties window, click the Advanced button

In the Sun Java System Connector for Microsoft Outlook properties dialog, select the Address
Book tab.
Within this tab you can change the following Address Book properties:
■ Address Book Server URL — add the URL path portion to the server information. This is

the URL used to connect to the Address Book Server from Outlook. The default URL is
http:// server:80/uwc.
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■ Use Alternate User account — if this checkbox is enabled, Address Book Server uses an
alternate user account than the account specified under the Sun Java Enterprise System tab.
Enter the User Name and User Password for this alternate Address Book Server account in
the appropriate fields.

When you are finished making changes, click OK.

Configuring Global Address List Properties

▼ To Change Global Address List Properties
In the Folders List, right-click Folders - your name.

In the pop-up menu, select Properties for Folders - your name.

In the Mail Folder Properties window, click the Advanced button

In the Sun Java System Connector for Microsoft Outlook properties dialog, select the Advanced
tab.
Within this tab you can change the following global address list properties:

■ Search Base — the basedn from which the LDAP searches are performed.
■ Use Alternate User account — if this checkbox is enabled, the global address list uses an

alternate user account than the account specified under the Sun Java Enterprise System tab.
Enter the User Name and User Password for the alternate account in the appropriate fields.

■ Anonymous bind — if this checkbox is enabled, LDAP does not authenticate before
performing a search. This option is useful for environments that do not have strong access
controls. Do not enable this checkbox if your LDAP server requires authentication.

When you are finished making changes, click OK.

Configuring Store and Logging Properties

▼ To Change Store and Logging Properties
In the Folders List, right-click Folders - your name.

In the pop-up menu, select Properties for Folders - your name.
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In the Mail Folder Properties window, click the Advanced button

In the Sun Java System Connector for Microsoft Outlook properties dialog, select the Advanced
tab.

a. Within this tab you can change the following information store properties:

■ File Path — the path for the PST database files. This setting cannot be changed.
■ Synchronize All — updates the local Outlook mail, calendar, task, and contacts data

from the Mail Server, Calendar Server, and Address Book Server. This will delete all local
mail, calendar, contact, and task items. All mail, calendar, task, and contacts attachments
and embedded data objects will also be removed. Click Yes to continue or No to cancel.

■ Personal Folders — updates your personal folders information.

b. You can also change the following logging properties:

■ Log File — the location of the log file. The default is C:\\Documents and Settings\
userid\Local Settings\Temp\Sun Outlook Connector Logs\sjoc.log . This setting
cannot be changed.

■ Log Level — specifies the level of logging. The choices are: Debug Low, Debug,
Information, Warning, Error, and Critical Error.

When you are finished making changes, click OK.
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Working with Email Folders

This section describes how to work with email folders and provides some tips on features that
are specific to Sun Java System Connector for Microsoft Outlook.

The following topics are discussed in this chapter:

■ “Accessing Your Inbox” on page 41
■ “Sharing Your Mail Folders” on page 42
■ “Subscribing to a Shared Mail Folder” on page 43
■ “Unsubscribing from a Shared Mail Folder” on page 43
■ “Working Offline” on page 44
■ “Changing the Folder Class” on page 45
■ “Synchronizing Folders” on page 46
■ “Setting Up an Out of Office Message” on page 46
■ “Setting Up Server-Side Mail Filters” on page 47

Accessing Your Inbox
You can access your email inbox on the Sun Java System Messaging Server using one of the
following methods:

■ Select the Inbox subfolder under Folders - your name .
■ In the Outlook Today view, select Inbox under the Messages category.
■ Select Inbox under the Outlook Shortcuts view.
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Sharing Your Mail Folders
You can grant access to or share one of your mail folders to other users. The user may then
subscribe to that shared folder.

▼ To Share One of Your Mail Folders
Right-click the folder you wish to share and select Properties.
The properties dialog for that folder appears.

Select the Permissions tab.

Within the Permissions tab:

■ If you know the userID of the person to which you want to share this folder, enter the userID
and click Add. The specified userID appears in the list below.

■ If you do not know the userID, click Search to search your address book directory.

Select the userID (or anyone) from the list and choose the permission rights you wish to grant.
The available permission rights are:

■ Read only
■ Read and write
■ Read, write, and manage
■ None

You must select at least read only in order to share a folder with another user.

If you wish messages to be sent directly to this folder, enable the“Enable direct delivery of email
to this folder”checkbox. This enables the ability to send email directly to this folder using the
following syntax:
user part of email address + folder name @ domain part of email address

For example, if the checkbox is enabled in John Smith's engineering folder, anybody will be
able to send a message to John using the address john.smith+engineering@sesta.com . This
message is delivered directly in the engineering folder. If the checkbox is not enabled, a
message sent to such an address is delivered to John Smith's Inbox.

Click Apply to apply changes or OK to apply changes and exit the dialog.

1

2

3

4

5

6

Sharing Your Mail Folders

Sun Java System Connector for Microsoft Outlook 7.2 User's Guide • March 200742



Subscribing to a Shared Mail Folder

▼ To Subscribe to a Shared Mail Folder
In the Folder List, right-click Shared Folders and select Properties.
The Shared Folders Properties dialog appears.

Select the Subscribe tab.

Click Subscribe.

In the Add Shared Folders dialog:

■ If you know the owner’s userID of the folder to which you wish to subscribe, enter that
userID and click Query.

■ If you do not know the owner’s userID, click Search to search your address book directory
for available folders.

The folders that are available to be shared and are not already subscribed by you are listed.
Select one or more folders in the list and click Add to subscribe.

Click OK and the subscribed folders appear in the Shared Folders list in the Shared Folders
Properties dialog.

Click OK in the Shared Folders Properties dialog and the subscribed folders appear as a
subfolder of your Shared Folders.

Unsubscribing from a Shared Mail Folder

▼ To Unsubscribe from a Shared Mail Folder
In the Folder List, right-click Shared Folders and select Properties.
The Shared Folders Properties dialog appears.

Select the Subscribe tab.
A list of subscribed folders appears in the Shared Folders list.

Select the folder from which you wish to unsubscribe and click Unsubscribe.
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Click OK and your Shared Folders are updated to remove that folder.

Note
You cannot change the permission rights of a shared folder—only the folder owner can change
permissions. You can only view the permissions granted to you.

Working Offline
You can choose to work offline with your Sun Java System Connector for Microsoft Outlook
folders.

Setting the Offline and Online Mode

▼ To Work Offline

In the File menu select Work Offline (Sun Java System Connector).
The Work Offline dialog appears.

Click Yes to download messages before going to offline mode. You can set the size limit of the
downloaded. See “Configuring Mail Properties”on page 36 for instructions on setting these
properties.
Only the messages in folders selected for offline use will be downloaded. See “Selecting a Folder
for Offline Use” on page 44 for instructions.

Click No if you do not wish to download any messages.

A check appears next to this menu item.

Once you are in offline mode, Connector for Microsoft Outlook disconnects from the server,
and all subsequent operations (for example composing, deleting, and moving messages) will
occur on your local machine until you switch back to online mode.

▼ To Return to Online Mode

In the File menu select“Work Offline (Sun Java System Connector).”
The check disappears from this menu item.

Selecting a Folder for Offline Use
You can specify a folder to download for offline use.
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▼ To Select a Folder for Offline User

Right-click on the folder you want to download and select Properties.
The Properties dialog for that folder is displayed.

Select the Advanced tab.

Enable the box next to“Select this folder for offline use.”

Click OK or Apply.

Changing the Folder Class
You can use Outlook’s New→Folder menu option to create a folder that contains journal, note,
task, or mail items. These items in any newly created folder are stored on the mail server.

Note – The items in the default Journal and Notes folders are stored on the mail server. The items
in the default Calendar, Tasks, and Contacts folders are stored in the calendar server (Calendar
and Tasks) and address book server (Contacts). No subfolders may be created under the default
Calendar, Tasks, or Contacts.

▼ To Change the Folder Class
Right-click on the folder you want to change and select Properties.
The Properties dialog for that folder is displayed.

Select the Advanced tab.

Enable the box next to Change this folder to contain .

Select which class of folder you want from the pull-down list.

Click OK or Apply.
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Synchronizing Folders
You can synchronize a single mail folder or all folders (including mail, calendar, tasks, and
contacts). Synchronizing updates the local data from the server. This deletes all local items. All
mail attachments and embedded data objects will also be removed.

▼ To Synchronize a Single Mail Folder
From the folders list, right-click on a mail folder.
The folder properties window is displayed.

In the folder properties window, select the Advanced tab.

Click“Empty and resync.”
A dialog appears indicating that the folder is synchronizing. The dialog disappears when
complete.

Click OK to close the folder properties window.

Synchronizing All Folders

To synchronize all folders, including mail, calendar, tasks, and contacts, see “Configuring Store
and Logging Properties” on page 39.

Setting Up an Out of Office Message
You may wish to set up an out of office message to be sent as a reply to senders in your absence.

▼ To Set Up Your Out of Office Message
Select Tools→Out of Office Message.
A browser opens to the “Options — Mail Vacation Message” page of Sun Java System
Communications Express. You can set up your out of office message from this page.
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Setting Up Server-Side Mail Filters
You may wish to apply filters to your mail folders. These filter rules are stored on the mail
server.

▼ To Apply Server-Side Filters to Mail Folders
Select Tools→Mail Filter.
A browser opens to the “Options — Mail Filters” page of Sun Java System Communications
Express. You can set up mail filters from this page.

●
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Working with Calendar Folders

This section describes how to work with calendar folders and provides some tips on features
that are specific to Sun Java System Connector for Microsoft Outlook.

The following topics are discussed in this chapter:

■ “Accessing Your Calendar” on page 49
■ “Sharing Your Calendar” on page 49
■ “Subscribing to a Shared Calendar” on page 50
■ “Unsubscribing From a Shared Calendar” on page 51
■ “Synchronizing Folders” on page 51
■ “Creating Multiple Calendars” on page 52

Accessing Your Calendar
You can access your default calendar on the Sun Java System Calendar Server using one of the
following methods:

■ In the Folder List, select the Calendar subfolder under Folders - your user name.
■ In the Outlook Today view, select Calendar.
■ Select Calendar under the Outlook Shortcuts view.

Sharing Your Calendar
You can grant access to your calendar to another user. That user may then subscribe to your
calendar. The access permissions range from being able to read your calendar, to allowing
another user to create, modify, or delete events in your calendar.
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▼ To Share Your Calendar
Right-click the Calendar folder you wish to share and select Properties.
The properties dialog for that folder appears.

Select the Permissions tab.

Click Add user.

In the Add User dialog, enter the userID and choose the permission settings, or click Search to
search for a user.
The available permission rights are:
■ Read only
■ Read and write
■ Read, write, and manage
■ None

You must select at least read only in order to share a folder with another user.

Click OK to delegate access to your calendar to the specified user.

Note

If you are granted access to another calendar, and create an event in that calendar, the calendar
owner is listed as the organizer of that event. Any email reminders sent about that event is sent
on behalf of the calendar owner.

Subscribing to a Shared Calendar
Another user can grant you access to his or her calendar.

▼ To Subscribe to a Shared Calendar
In the Folder List, right-click Shared Calendars and select Properties.
The Shared Calendar Properties dialog appears.

Select the Subscribe tab.

Click Subscribe.

In Add Calendar dialog:
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■ If you know the userID of the calendar to which you wish to subscribe, enter that userID and
click Query.

■ If you do not know the userID of the calendar to which you wish to subscribe, click Search to
search your address book directory for available calendars.

The folders that are available to be shared and are not already subscribed by you are listed.
Select one or more folders in the list and click Add to subscribe.

Click OK in the Shared Calendar Properties window.

The calendar is added to your list of subscribed calendars.

Unsubscribing From a Shared Calendar

▼ To Unsubscribe From a Shared Calendar
In the Folder List, right-click Shared Calendars and select Properties.

The Shared Calendar Properties dialog appears.

Select the Subscribe tab.

A list of subscribed calendars appears in the Calendars list.

Select the calendar from which you wish to unsubscribe.

Click Unsubscribe.

A dialog appears asking if you wish to unsubscribe from this calendar.

Click yes to unsubscribe. Click no to cancel.

The calendar will be deleted from your subscribed calendar list.

Synchronizing Folders
You can synchronize a calendar folder or all folders (including mail, calendar, tasks, and
contacts). Synchronizing updates the local data from the server. This deletes all local items. All
calendar attachments and embedded data objects will also be removed.
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▼ To Synchronize a Single Calendar Folder
From the folders list, right-click on a calendar folder.
The folder properties window is displayed.

In the folder properties window, select the Advanced tab.

Click“Empty and resync.”
A dialog appears indicating that the folder is synchronizing. The dialog disappears when
complete.

Click OK to close the folder properties window.

Synchronizing All Folders

To synchronize all folders, including mail, calendar, tasks, and contacts, see “Configuring Store
and Logging Properties” on page 39.

Creating Multiple Calendars
You may create and share multiple calendars, in addition to your default calendar. These
calendars may only be created at the top-most folder level.

Note – No subfolders may be created under the default Calendar folder.

▼ To Create a New Calendar Folder
From the top menu, select New→Folder.

In the Create New Folder window:

a. Enter a name for the new calendar.

b. Select Appointment Items in the“Folder contains”field.

c. Click OK.

The new calendar folder appears under the main folders list.
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Free/busy Status

Your free/busy status does not include appointments and meetings scheduled in non-default
calendars.

You may also share your non-default calendar and subscribe to another user's non-default
calendar. See “Sharing Your Calendar” on page 49 and “Subscribing to a Shared Calendar” on
page 50 for instructions.

More Information

See Also

Creating Multiple Calendars
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Working with the Contacts Folder

This section describes how to work with your Contacts folder and provides some tips on
features that are specific to Sun Java System Connector for Microsoft Outlook.

The following topics are discussed in this chapter:

■ “Accessing Your Contacts” on page 55
■ “Sharing Your Contacts Folder” on page 55
■ “Subscribing to Shared Contacts Folders” on page 56
■ “Unsubscribing From Shared Contacts” on page 57
■ “Adding Shared Contacts Folders to Select Names Dialog” on page 57
■ “Removing Shared Contacts Folders from Select Names Dialog” on page 58
■ “Creating Multiple Contacts Folders” on page 59

Accessing Your Contacts
You can access your default Contacts folderon the Sun Java System Address Book Server using
one of the following methods:

■ Select the Contacts subfolder under Folders — your name.
■ Select Contacts under the Outlook Shortcuts view.

Sharing Your Contacts Folder
You can grant access to your Contacts folder to other users. The user may then subscribe to
your Contacts folder. The access permissions range from being able to read your Contacts
folder, to allowing another user to create, modify, or delete contacts.
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▼ To Delegate Access to Your Contacts Folder
Right-click the Contacts folder you wish to share and select Properties.
The Contacts Properties window appears.

Select the Permissions tab.

Enter the user's ID and click Add, or click Search to search for users in your Address Book
directory.

Choose the permission settings when the user's ID is highlighted.
The available permission rights are:

■ Read only
■ Read and write
■ Read, write, and manage
■ None

You must select at least read only in order to share a folder with another user.

Click OK to delegate access to your Contacts folder to the specified user.

Subscribing to Shared Contacts Folders
Another user can grant you access to his or her Contacts folder.

▼ To Subscribe to Another User's Contacts Folder
In the Folder List, right-click Shared Contacts and select Properties.
The Shared Contacts Properties dialog appears.

Select the Subscribe tab.

Click Subscribe.

In the Add Shared Contacts dialog:

■ If you know the userID of the Contacts folder to which you wish to subscribe, enter that
userID and click Query.

■ If you do not know the userID of the Contacts folder to which you wish to subscribe:
a. Click Search.
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b. Select the user from the list in the Address Book dialog and click OK.

The userID and contacts are listed in the contacts list.

In the Add Shared Contacts dialog, select the userID from the contacts list and click Add.

Select the userID in the Shared Contacts Properties window and click OK.
The user's Contacts folder are added to your list of subscribed Contacts folder.

Unsubscribing From Shared Contacts

▼ To Unsubscribe From a Shared Contact List
In the Folder List, right-click Shared Contacts and select Properties.
The Shared Contacts Properties dialog appears.

Select the Subscribe tab.
A list of subscribed Contacts folders appears in the Contacts list.

Select the Contacts folder from which you wish to unsubscribe.

Click Unsubscribe.
The Contacts folder is deleted from your subscribed contacts list.

Adding Shared Contacts Folders to Select Names Dialog
When composing a new message, you can click the To button which displays the “Select
Names” dialog. This dialog displays addresses from your Contacts folder and the global address
list.

▼ To Add a Shared Contact Folder to the Select Names
Dialog

In the Folder list, right-click Contacts and select Properties.
The Contacts Properties dialog appears.

Select the Outlook Address Book tab.
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Enable the“Show this folder as and e-mail Address Book”checkbox.

Click OK.

Removing Shared Contacts Folders from Select Names Dialog
After unsubscribing to a shared contact, it is not automatically removed from the “Select
Names” dialog.

To remove the shared contact from this list, two solutions exist:

■ If the subscribed contact has been added to the Select Names dialog, uncheck the “Show this
folder as an e-mail Address Book” checkbox from the Outlook Address Book property page
before unsubscribing from the contact.

■ Remove the contact directly from the address book properties:
In Outlook XP:
1. Select Tools→Email account.
2. Choose “View or change existing directories or address books” and select “Microsoft

Outlook Address Book” to change.
3. Select the item to remove from your address book.

In Outlook 2000:
1. Select Tools→Services from the Outlook menu.

The Services window is displayed.
2. Select the Services tab.
3. Select “Outlook Address Book” from the list of services set up in your profile and click

Properties.
The Microsoft Outlook Address Book properties window is displayed.

4. Select the item to remove from your address book and click close.

Note – The user must log out and log in again for the change to take effect.
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Creating Multiple Contacts Folders
You may create and share multiple Contacts folders, in addition to your default Contacts folder.
These Contacts folders may only be created at the top-most folder level.

Note – No subfolders may be created under the default Contact folder.

▼ To Create a New Contact Folder
From the top menu, select New→Folder.

In the Create New Folder window:

a. Enter a name for the new Contacts folder.

b. Select Contact Items in the“Folder contains”field.

c. Click OK.

The new Contacts folder appears under the main folders list.

You may also share your non-default Contacts folder and subscribe to another user's
non-default Contacts folder. See “Sharing Your Contacts Folder” on page 55 and “Subscribing
to Shared Contacts Folders” on page 56 for instructions.
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Troubleshooting

This chapter provides troubleshooting tips when using Sun Java System Connector for
Microsoft Outlook.

If Microsoft Outlook Is Not Your Default Email Client
The Sun Java System Connector for Microsoft Outlook can be installed only if Microsoft
Outlook is set to be your default email client. If Outlook is not set as your default email client,
the Setup Wizard will notify you of the problem (in an error message after the Welcome
screen), and prompt you to acknowledge the notice and exit the program.

▼ To Set Outlook as Your Default Mail Client
Open your Windows Control Panel. If you are running Windows XP (only): Select“Switch to
Classic View.”

Double-click on Internet Options.

Select the Programs tab from the Internet Properties window.

Select Microsoft Outlook from the Email pull-down menu.

Click OK.

You may rerun the Setup Wizard after you set your default email client to Outlook.
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If a Sun Synchronization Program Is Installed, and Must Be
Removed

The MAPI services for the Sun Java System Connector for Microsoft Outlook are a required
component of the Connector installation, but cannot coexist with the Sun Java System
Synchronization program (previously known as the ONE Sync program). If one of these Sun
synchronization programs is installed on your workstation, the Setup Wizard will notify you of
the problem (in an error message after the Welcome screen), and prompt you to acknowledge
the notice and exit the program. You may then rerun the Setup Wizard after you remove the
synchronization program.

Note – To synchronize your Palm device, WinCE device or Pocket PC device with Outlook, we
strongly recommend that you use the sync software distributed with your device, rather than
the Sun synchronization software. Changing to the sync software distributed with your device
may require uninstalling and reinstalling the Palm Desktop software.

▼ To Remove the Synchronization Program
From your Start menu: Select the Uninstall... option for the program you want to uninstall.
Select one of the following:

■ Programs→Sun Java System Synchronization→Uninstall Sun Java System
Synchronization.

■ Programs→Sun ONE Synchronization→Uninstall Sun ONE Synchronization.

In the Uninstallation window, follow the prompts to uninstall the software.

Click Finish to complete the uninstallation process.

If you want to continue using the Sun synchronization software to sync to the data of your other
device: Reinstall the software, but do not select the checkbox for the Microsoft Outlook 98/2000
translator during the installation.
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If a Personal Folder (.pst) File Conversion Is Interrupted
Since Personal Folder (.pst) file conversions can run for many minutes or even hours for large
files, an interruption of the process— by a power failure, for example— could be especially
inconvenient if it meant having to repeat the lengthy process from scratch. The Setup Wizard
therefore offers a recovery feature that lets you resume an interrupted conversion from
wherever it was interrupted. Note that this recovery feature is available only when an
interruption occurs during a “large” Personal Folder conversion— not during a profile
conversion or during the conversion of smaller .pst files. (Your network administrator has
previously set a size limit to define the difference between “large” and “small” files.)

If the conversion of a large .pst file is interrupted, the Wizard will temporarily add to your
desktop an icon for the recovery feature, titled “Finish Aborted Sun Java System Connector
Wizard Conversion.” The recovery feature will not work if you simply restart the Setup Wizard
as you ran it for your original conversion; you must start it from the desktop “Finish” icon, as
shown in Figure 8–1.

To complete an interrupted conversion: Start the recovery mode of the Sun Java System
Connector Setup Wizard, by double-clicking the “Finish” desktop icon.

The Wizard then displays its Welcome screen, as shown in Figure 8–2, and notifies you that it
has detected an incomplete conversion.

FIGURE 8–1 To Finish an Aborted Conversion: The Desktop “Finish” Icon

If a Personal Folder (.pst) File Conversion Is Interrupted

Chapter 8 • Troubleshooting 63



This recovery procedure is an abbreviated version of the original Setup procedure, as described
in “The Setup Procedure” on page 19. The Wizard remembers, from its interrupted run, which
user profile and which Personal Folders (.pst) files you selected for conversion, so it will not
prompt you for that information again.

Instead, when you click Next from the Welcome screen shown here, the Wizard skips ahead to
step 5 or 6 of the original Setup procedure: to prompt you for your old Exchange login
information (step 5) if you previously used Outlook on this computer, or for your new Sun Java
System Account login information (step 6) if you will be a new Outlook user. From step 5 or 6
forward, the procedures are identical, so please refer to “The Setup Procedure” on page 19.

Logging
This section provides troubleshooting tips for logging and log reports.

Enabling Logging for Troubleshooting
In order to keep track of any problems that may arise with your mail folders or messages, it is
recommended to turn on the logging function for debugging purposes.

▼ To Enable Logging

From the Help menu, select About Sun Java System Connector for Microsoft Outlook.

In the About dialog, click Debug Logs.

FIGURE 8–2 Setup Wizard Welcome Screen, to Resume an Interrupted Conversion
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In the Debug Logs dialog, enable the checkbox next to Turn on debug logging.
The Log file path indicates the location of the log files.

When you are finished, click OK.

Sending a Log Report
You can send a log report of any problems to your technical support representative.

▼ To Send a Log Report

Turn on logging as indicated in “Enabling Logging for Troubleshooting”on page 64

Return to Outlook and attempt to reproduce the steps the caused the problem.

From the Help menu, select About Sun Java System Connector for Microsoft Outlook.

In the About dialog, click Debug Logs.

In the Debug Logs dialog, enter the email address of your technical support representative.

Click Report.
A new message appears addressed to technical support. A copy of your log file and your system
information is also included in the message.

You may enter any more information, or cc anybody else before sending the message.

Increasing Log Files and Size
Log files are regularly reused and overwritten by new log files. This occurs more frequently for
users with large mailboxes. You can increase the size of your log files or increase the number of
logs files by resetting three registry keys. The registry keys are:

■ HKEY_CURRENT_USER\Software\Sun Microsystems\Outlook Connector

■ Maximum Log File Size

■ Maximum Number Log Files
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Assigning Tasks
When assigning tasks to other users, you cannot set different permissions to tasks and your
calendar. The permissions assigned to your calendar applies to your tasks, and visa versa.

If you are assigned a task, you cannot read the message in your inbox. Move it to one of your
local folders in order to read the task message.

If a Server is Down
If Messaging Server is down, you will be unable to log into Outlook. You can, however, work in
offline mode.

If Messaging Server is working, but Calendar Server or Address Book Server is down, you can
log in to Outlook, but you will be unable make any changes (for example, create new events,
new contacts).

Viewing Message Source
If a message does not display correctly, or if you need a message's header information for
debugging purposes, you can view the source information of that message.

▼ To View the Message Source
Double-click on a message from the message list.
A new window displays containing the message.

In the message window, select View→Message Source.
The Message Source window displays header and source information for the message.

You can copy the information and send it to support for debugging.

Click Close to close the window.

Viewing Message Source While Composing a Message

You can also view the message source while composing a message by selecting View→Message
Source in the Message window.
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Losing Connection Due to Timeout
If your connection speed is too slow, or you need to retrieve a large amount of data and lose
connection due to timeout, you may increase the timeout value by configuring the
REGKEY_CONN_TIMEOUT registration key located under HKCU\Software\Sun
Microsystems\Outlook Connector\Connection Time Out. The default value is 60 seconds.

Repairing Errors in the .pst File
If you receive an error message when attempting to switch between folders, you will need to
locate the .pst file currently being used and run the Inbox Repair Tool on the file.

The error message displayed for this type of problem is: "Errors have been detected in PST file.
Quit all email enabled applications and run repair tool."

Locating the .pst File
The .pst file that is currently being used must be located before running the Inbox Repair Tool.

▼ To Find the Current .pst File

In the Folders List, right-click Folders - your name.

In the pop-up menu, select Properties for“Folders - your name.”

In the Mail Folder Properties window, click the Advanced... button.

In the Sun Java System Connector for Microsoft Outlook properties dialog, select the Advanced
tab.
In the File Path field under the Store section, note the path provided. This is the path where the
currently used .pst file for your Outlook profile is located.

Repairing the .pst File with the Inbox Repair Tool
The Inbox Repair Tool (scanpst.exe) is a tool designed to help repair problems associated with
Personal Folder (.pst) files. In addition, the scanost.exe tool is used to repair offline folders
(.ost) files. The Inbox Repair Tool automatically installs during the Outlook setup. These
programs are typically located in one of the following folders depending on your Outlook
version:
■ Outlook 2000: Program Files\Common Files\System\Mapi\1033\NT\
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■ Outlook 2002 (Outlook XP): Program Files\Common Files\System\Mapi\1033

■ Outlook 2003: Program Files\Common Files\System\MSMAPI\1033

Note – If you cannot find scanpst.exe in any of the above paths, perform a search for the file.

▼ To Run the Inbox Repair Tool

Double-click the scanpst.exe file.

Enter the path and file name of the .pstfile, or click Browse to locate the file.

Click Start.
After successfully repairing your .pst file, you may resume email activities.
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